We all know that thin-film properties are rarely identical to those of corresponding bulk materials. Not only do they differ, but they can vary significantly with deposition conditions. Even similar materials, deposited under the same conditions in two nominally identical machines, may exhibit subtle differences in their properties. The variation can be partly due to differences in the crystalline structure of the films. High temperature forms, different from those common at normal temperatures, are frequently frozen into the films. Sometimes the films are amorphous, a metastable state that often does not exist in bulk. Strain birefringence can cause changes in optical parameters. A fairly common reason for the differences, however, is that the films may lack the solidity of bulk materials. They contain voids. Often the voids are pore-shaped so that they are capable of adsorbing material, especially atmospheric moisture, that then changes the optical properties still further. Energetically-deposited films, because of their greater solidity, are generally more stable than those simply thermally evaporated. But they can exhibit high compressive strain or compositional differences. This makes it difficult to maintain a library of film properties. The materials library of the Essential Macleod includes some apparently duplicate entries. Closer inspection will reveal that they are not completely equivalent. The notes section of the material document will usually provide information on the source of the data.

An exact description of the film microstructure is impossible, and so we use statistical parameters, like averages. As long as the wavelength is much larger than the film features, so that the optical properties are themselves average, this works very well. Of all the parameters that may describe aspects of the microstructure of a thin film, the most important by far is packing density. Packing density, \( p \), measures the average solidity of the film. It is defined as:

\[
p = \frac{\text{Volume of solid part of film}}{\text{Total volume (solid plus voids)}} \tag{1}
\]

Figure 1. Variation of refractive index with packing density for the four principal models. The solid index is 2.35 and the void index 1.00. The linear law is the Kinosita and Nishibori model.
How can we use packing density to give some idea of the properties of the particular film exhibiting it? The film is essentially a composite material consisting of one component dispersed in another. Attempts to express the optical properties of composite material in terms of their components began with Mosotti in the early 19th Century and are still in progress. There are many different models. Although packing density is the fundamental parameter, it is the detailed microstructure that determines the most appropriate model for a given film.

Take a combination of two dielectric materials, one with high and the other with low index. Imagine that at a given packing density the high-index fraction forms completely separated particles dispersed in the low index. The polarization of the high-index particles (electrical, not optical polarization) inhibits the electric field from penetrating it. The electric field is, therefore, concentrated in the low index material, depressing the index of refraction of the composite material. Now suppose the opposite, with the low index forming the isolated parts. The electric field is now forced more into the high index, raising the composite index. In a third possibility, neither fraction assumes the rôle of inclusion nor of matrix, yielding an intermediate value of index. In all these cases the packing density is identical, but the appropriate model is different. Maxwell-Garnett, Bruggeman and Bragg and Pippard are three commonly used models. Maxwell-Garnett is the oldest and, in its original form, assumed a matrix containing spherical inclusions. Although directed at metallic inclusions in a dielectric matrix, the results are of general application. Bragg and Pippard followed a different theoretical route but emerged with virtually the same result including a wider range of inclusion shapes. Both these models clearly distinguish matrix from inclusion, with the assumption that the density of inclusions is small. Then Bruggeman assumes the impossibility of distinguishing matrix from inclusion. All this presents us with a difficulty. We would prefer a single model, and the simpler, the better.

Kinosita and Nishibori, in a 1969 study of moisture adsorption in magnesium fluoride [K. Kinosita and M. Nishibori, "Porosity of MgF2 films - evaluation based on changes in refractive index due to adsorption of vapors," *Journal of Vacuum Science and Technology* 6, 730-733 (1969)] suggested a much simpler model, a linear interpolation between the void index at zero packing density and the solid index at unity packing density. They actually used porosity $q$ rather than packing density $p$: $q = (1 - p)$.

$$n_{\text{film}} = (1 - p)n_{\text{void}} + pn_{\text{solid}}$$

How do the various models compare? Figure 1 shows calculations where the voids are taken as the inclusions in the appropriate models. The differences are really not great. There are few published results and those existing, inevitably show some fluctuations. Two recent studies concern titania and hafnia and they are shown in Figure 2 and Figure 3. Added to each curve is the straight line of Kinosita and Nishibori assuming a void index of unity. The fit is reasonable. An additional factor is that fortunately, whichever model we consider, the value derived for the composite index is a single-valued function of the packing density.

For all these reasons and especially for simplicity, we chose to use the Kinosita and Nishibori model as our usual one. However, we do know that the voids, particularly when they have the form of pores run-
In some design operations we wish to vary the refractive index of our materials and packing density that retains the dispersion of the material is a convenient way of accomplishing the variation. This is used in Simplex, Simulated Annealing and in Differential Evolution. We can imagine cases where the materials may exhibit rather greater extinction coefficients that should be included in the model. This option is, therefore, included. General... in the Options menu where the Designs tab presents a check box Use Packing Density to Adjust Extinction Coefficient. Since the unfilled voids have zero extinction coefficient, the formula for the extinction coefficient is slightly different.

\[
k_{\text{film}} = (1 - p)k_{\text{void}} + pk_{\text{solid}}
\]  

The two expressions together will fit qualitatively the effect of porosity in high-performance metals like silver, increasing \( n \) and reducing \( k \).

There will be cases where this simple and exceedingly useful model is insufficiently precise. For such cases we provide in Function a script, Composite Materials, that presents a number of the more popular models and generates a material document from a combination of two chosen materials.

Dielectric thin films can suffer from inhomogeneity, that is a variation of their optical constants through the thickness of the film. In our models of such behavior we almost invariably model them as inhomogeneous in their refractive index but homogeneous in their extinction coefficient. Why is this?

Given reflectance and transmittance measurements of a thin film that shows good fringes, it is fairly straightforward to establish whether or not inhomogeneity exists in its refractive index, that is the refractive index is varying throughout the thickness of the film. If the film is reasonably transparent, its extinction coefficient acts primarily on transmittance and has little effect on reflectance. This implies that a thin film exhibiting at its halfwave thicknesses a reflectance different from that of the substrate, can be taken as exhibiting inhomogeneity. If the effect in transmission is of the same magnitude then this confirms it. If it were absorption then we would expect transmittance to show a much greater effect. Thus inhomogeneity in refractive index is not difficult to detect. We do not have the same degree of success with extinction coefficient.

There are several contributing factors. The extinction coefficient, even in a quite heavily absorbing dielectric film has a numerical value usually some two or so orders of magnitude below the refractive index. Refractive index, therefore, dominates in terms of reflectance. A shift in index of 10% has a significant effect on reflectance and transmittance, but a similar 10% change in extinction coefficient has a very much smaller, virtually negligible, effect. Then the extinction coefficient operates on the amplitudes of the partial waves in the film while the refractive index operates on the phase. The fall in the amplitude can certainly be detected but there is little positional sensitivity. Transmittance is symmetrical. Thus a rising distribution of extinction coefficient will give the same result as a falling one because of this symmetry. Then a heavily absorbing film with an appreciable extinction coefficient will exhibit the reflectance of either the front or back surface only. There will be no appreciable transmission. Thus there is no simple measurement that is particularly sensitive to inhomogeneity in extinction coefficient. There are, of course, very subtle differences that we can detect, for example, in comparing accurate admittance loci but we are not good at measuring them.

As an example we take a nondispersive dielectric film of index 2.00 and extinction coefficient 0.01 with optical thickness three full waves at 1000nm and we compare its properties with a similar film of identical thickness with index 2.00 but with an extinction coefficient varying linearly in optical thickness from zero at the front surface to 0.02 at the rear.
The knock on the door indicated the arrival of one of his students.

“Come in,” said James, wondering what the latest problem might be.

“It is a calculation I am doing on coating uniformity and the requirements for preserving the figure of an interferometric component,” explained the student, “and I don’t quite understand what is going on. We have a front surface mirror that has to have very high reflectance at 550 nm and so we are using a 23-layer system of tantala and silica, all quarterwaves at 550 nm. The incident medium is air and the substrate glass. The specification calls for a flatness to give a maximum wavefront error of 1/20th of a wave at 550 nm. I know the specification is all to do with phase, and I thought I would like to do the calculation manually to make sure I understand, and then verify the result using the program that we have in the lab.

“I started with a uniformity error of -5.0%. With no error the phase change on reflection from the coating is -180° (although it could equally be +180°). With a negative five percent change in the thicknesses the phase shift becomes -166.226°. Now our sign convention is that if we keep time constant then the phase of a wave becomes more negative with increasing distance along the direction of propagation. Our reference phase to mark the shape of the wavefront we can take as -180° (the wavefront is any surface through points of constant phase) and that is a bit more negative, and so the actual wavefront must be leading a little so that if we assume a zero thickness error at the center and the -5% uniformity error at the periphery of the component then the wavefront will be concave with the error at the periphery (180 – 166.226)/360 waves and that gives 0.03826 waves. This total error would suggest that a degree of uniformity of 5% would be completely adequate since, as I explained, the specification calls for maximum wavefront error of 1/20th of a wave at 550 nm.

“However, the program we have in the lab tells me that the wavefront will be convex with a much larger total error of 0.2902 waves. I am inclined to believe the computer, although you have always told us to be very suspicious of computer results. The trouble is that a 5% uniformity error is really quite bad and I would suspect not good enough for interferometric components. So what am I doing wrong?”

“What is the total physical thickness of your coating?” asked James.

“It is 1806.71 nm” answered the student, slightly puzzled.

“Well here is the problem,” said James and proceeded to explain where the student had gone wrong. What did James say?

Please turn to Page 7 column 1 for the answer

(Continued from page 4)

We assume deposition over a substrate of constant index 1.52 with an incident medium of air. Reflectance, back reflectance and transmittance of the two films are compared in Figure 4 to Figure 6. The homogeneous results are plotted in red and in a fairly thick line. The inhomogeneous results are plotted over them in black. There is almost exact coincidence.

To include extinction coefficient in the various models of inhomogeneous behavior used in the design document, tick Use Packing Density to adjust Extinction Coefficient in the Designs tab of the General Options dialog.

Figure 6. Comparison of back reflectance calculations using homogeneous model (red) and model with linearly inhomogeneous extinction coefficient (black).
Plotting

The plotting facilities in the Essential Macleod are provided primarily for the display of calculated performance parameters but they can actually be used to plot almost anything, and, they are easy to use.

Figure 7 shows the contents of a text file that has no connection whatsoever with optical coatings. It contains a table of gasoline exports from the United States 1915-1930 (published in H Arkin and R R Colton “An outline of statistical methods”, Barnes and Noble, 1938.). We would like to plot these data.

Our first task is to bring these data into the Essential Macleod. To do this, drag the text file onto the Essential Macleod Desktop and the usual Import Data dialog will appear. The chosen data will be placed in a new table document. The same result is achieved if the data are copied to the Clipboard and pasted into a new table. Note that the new table can be chosen with only two columns. It will automatically expand to the required number of columns. Now that the data are in a table they can be plotted by selecting the dependent variable column, in this case the number of barrels, by clicking in the header, so that the entire column is highlighted, and then selecting Plot Column in the File menu. To add the column to an already existing plot, simply drag the column onto the plot.

Note that the independent variable (horizontal) for the plot must be listed in the first column. Should the first column not be the correct one then the appropriate column can be chosen by selecting it by clicking in its header and then using the Set Independent Column item in the Edit menu for the table.

Once the plot has been created, Figure 8, there are all kinds of editing tools that can turn it into whatever style is required. A right click anywhere in the plot opens a floating menu with a number of choices. Add Label, adds a label at the cursor, which can then be moved around by dragging with the mouse. Edit All Properties opens a full dialog of possible properties. If you have Function then even more options are available. Bar charts, polar charts and even three-dimensional charts are all possible objects.

Remember, too, to keep a set of plot templates so that you can shift easily from a plot suitable for a publication to one for a slide presentation.

Figure 7. Gasoline exports from the United States in the early 20th Century.

Figure 8. The plot of the data in Figure 7. The label was added manually as described in the text.
“What you have to remember,” explained James, “is that the phase calculation in reflection compares the phases of the incident and reflected beams exactly at the front surface of the coating. Because of the uniformity error, the front surface of your coating is no longer flat. What you have calculated is the kind of answer you would get for internal reflection at a surface where the shape of the surface remains constant whatever the error in uniformity. Because you are dealing with reflection at the outer surface of the coating, your 5% reduction in thickness moves your surface back some 5% of 1806.71 nm and that is 90.336 nm. The double traversal of this gives a wavefront error of 0.3285 waves at 550 nm and that yields a convex surface. Your phase change result has to be added to this, taking account of the sign, and it actually compensates slightly for the error, reducing the maximum convexity error of the wavefront to 0.2902 waves, exactly the answer you got from the computer. Your instinct this time was correct. Your calculation was incomplete.

“Now go and find out exactly what the uniformity requirements should be.”

The Essential Macleod has its share of helpful reminders like the ones shown in Figure 9. They really are intended to help. Documents like Designs, Stacks vStacks and so on don’t just store the details of the layer sequences but they hold a complete set of all the necessary data for all the performance calculations. Complete materials data are stored in a design document, for example, and before the document is displayed, the data are compared with the corresponding values in the current database and the slightest discrepancy triggers the warning shown in the figure, presenting the option of using the archived rather than the regular data. This is particularly useful when a design is shared. It is not necessary to supply the materials data separately because it is all in the archive.

The data comparison is complete. For materials, all the wavelength points with every value of \( n \) and \( k \), are checked. How strict a check? Since the computer has no idea of the particular circumstances and needs in any given case, the check must use the limits of precision. Anything less than that could be dangerous, but, with that, comes the common little problem of computers when large volumes of data at the limits of precision are compared: sometimes a discrepancy is detected when ideally there should be none. Designs that never used any materials other than those in the current database can be flagged as though they were using different materials. This can prove a little tiresome when you know very well that there have been no changes and it is just digital noise. So, as with all the other little messages, we add the option to stop its appearance by checking the never-bother-me-with-this-again box.

The messages have mostly had these check boxes for some time. But you have suppressed a particular message and for some reason you now want it back. Up till now that was a little more difficult, involving an adjustment to the registry. Reset all Messages is a new item at the foot of the Options menu and it does exactly what it says. You have cancelled the archive warning but you have received some designs from a colleague. You want to be sure that the archival information should be used if there is any discrepancy. Before you open the designs, simply click on Reset all Messages and all will be well.

Figure 9. Two of the various warning messages from the Essential Macleod.
Optical Coatings from Design through Manufacture

16-20 September 2013
Tucson, Arizona

This is our well-known standard course on the whole field of optical coatings with an emphasis on hands-on computer aided design. The course is a mixture of formal lectures and hands-on tutorials. It is important not only to know how to use the computer, but also to understand the computed results, and both are covered in detail. Calculation of the optical properties of a given thin-film coating is straightforward. Designing for desired optical properties is rather more difficult. Reverse engineering that attempts to identify the errors responsible for manufacturing failures is similar to design but requires an even greater level of understanding. Computers are absolutely necessary in these tasks and much of the course will involve learning effectively to use powerful computer tools, but knowledge of deposition techniques and thin-film behavior is also necessary for the effective designer. Extensive notes have been specially prepared for the course. They represent a valuable reference source and cannot be obtained except by taking the course.

The course, given by Angus Macleod, covers thin-film fundamentals and lasts around five hours. It is available on CD’s so that it can be played on a computer. The set is accompanied by a booklet summarizing the content. There are seven lectures with titles and durations:

1. Complex numbers 31 mins
2. Complex waves 20 mins
3. Optical admittance 37 mins
4. Admittance transformers 29 mins
5. Applications 59 mins
6. Matrix method 71 mins
7. Oblique incidence 60 mins

The price for the complete set is $600 (US) plus shipping.

Remember! During the first year after purchase, the price of the Concise Macleod will be credited against the cost of the Essential Macleod if you upgrade to it. All files from the Concise are compatible with the Essential

Macleod Medium
is prepared exclusively for members of their Update Service by
Thin Film Center Inc
2745 East Via Rotunda, Tucson, Arizona 85716-5227, USA
Tel: (520) 322 6171 Fax: (520) 325 8721
info@thinfilmcenter.com www.thinfilmcenter.com
Copyright © Thin Film Center Inc 2013 All rights reserved

Hong Kong: Dr.-Ing. Feng Qian
Leyfond Limited
Unit B, 9/F Winner Commercial Building
401-403 Lockhard Road
Wan Chai, Hong Kong
Tel: ++852 2575 6688 Fax: ++852 2575 6993
email: qianfeng1964@i26.com
web: www.leyfond.net

China: Ms Angie Zhu
Infotek Information Science and Technology,
Room 707, Yong Sheng Building
2025, West Zhongshan Rd
Xuhui District
Shanghai, 200030, P.R. China
Tel: 021-64860708 Fax: 021-64860709
email: sales@infotek.com.cn
web: www.infotek.com.cn

Singapore: Gary Ng
APP Systems Services Pte Ltd
11 Toh Guan Road East
#03-01 APP Enterprise Building
Singapore 608663.
Tel: 6668 4666 Fax: 6560 6616
email: gary.ng@appsystems.com.sg

Short Video Course

The course, given by Angus Macleod, covers thin-film fundamentals and lasts around five hours. It is available on CD’s so that it can be played on a computer. The set is accompanied by a booklet summarizing the content. There are seven lectures with titles and durations:

1. Complex numbers 31 mins
2. Complex waves 20 mins
3. Optical admittance 37 mins
4. Admittance transformers 29 mins
5. Applications 59 mins
6. Matrix method 71 mins
7. Oblique incidence 60 mins

The price for the complete set is $600 (US) plus shipping.

Essential Macleod Concise Edition

Macleod Medium

Course News